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LESSON 1 — WORK PACKAGING
OVERVIEW

Lesson Duration:  45 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Describe the two modules of Plan

l Explain the high-level work flow of Plan – Work Packaging

Lesson Topics

1.1 Plan Work Packaging Overview 10
1.1.1 InEight Plan Work Flow 10
1.1.2 Work Packaging 12

Lesson 1 Review 16
Lesson 1 Summary 16



1.1 PLAN WORK PACKAGING OVERVIEW

InEight Plan is an application within the InEight portfolio of products. It is a tool for engineers and
superintendents to plan their work and track quantities during the construction of the project.

InEight Plan is organized into two modules:

Plan Modules

Work Packaging Creating and managing work packages.

Quantity Tracking Creating and managing components and claiming schemes.
Claiming completed quantities.

1.1.1 InEight Plan Work Flow

The below workflow illustrates the functions of both InEight Plan and InEight Progress, and how data
flows between the two applications.
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Scenario

You are a Project Manager about to start construction of a Steel Structure project. Your first step
before starting construction is to break the project down into pieces that are more manageable.

The image below depicts a layout for a steel structure project.  The project consists of erecting 30
separate steel structures on opposite sides of a road.  Each structure or module has been assigned a
number 1-30.
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1.1.2 Work Packaging

Work Packaging breaks down projects into small, manageable scopes of work so that operations can be
assigned to responsible supervision, executed, and tracked effectively. In InEight Plan, you can break
the work of your project into construction work areas (CWAs), construction work packages (CWPs) and
installation work packages (IWPs).
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As mentioned in the scenario above, the scope of the Steel Structure project was too big to manage
without segmenting it down to work packages representing one to four weeks’ worth of work. In Plan,
this breakdown of the project could look like this:

1.1.2.1 Work Package Details

Work package details include the following information:

l Work sequence

l Budget
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l Resources required

l Components and quantities

l Constraint Management

l Safety, quality, and environmental concerns

For your Steel Erection work plan, you can create a work package for each module. 
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In Work Package Management, you will learn about work plans and work packages in
detail, including how to create them and define plan details.

1.1.2.2 Comprehensive Workflow

The diagram below displays both sections of Plan and how they integrate with InEight Progress, InEight
Control and your Payroll system.

You will notice the areas where you create associations between work packages and daily plans, work
packages and components, and components and claiming schemes.

The details of this workflow and the step by step functions within it will be covered in the remaining
lessons of this and the Plan Quantity Tracking module and the Progress module.
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Lesson 1 Review

1. Which two of the following are modules in Plan?

a. Quantity tracking

b. Benchmarking

c. Work packaging

d. Control

e. Reporting

f. Daily planning

2. Which one of the following represents the order for breaking down your project scope
from larger to smaller pieces within InEight Plan?

a. Project > CWA > CWP > IWP

b. CWA > IWP > Project > CWP

c. Project > Work plan > CWA > CWP

d. Project > CWA > IWP > CWP

3. According to the InEight Plan workflow diagram, installation work packages (IWPs)
associate with which of the following? (Select all that apply)

a. Inspections

b. Components

c. Web daily planning

d. Estimating

e. Mobile daily planning

f. Payroll

Lesson 1 Summary

As a result of this lesson, you can:

l Describe the two modules of Plan
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l Explain the high-level work flow of Plan – Work Packaging
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LESSON 2 — GENERAL NAVIGATION

Lesson Duration:  30 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Navigate the InEight Plan Work plans page

l Manage columns

l Manage data blocks

l Create viewsets

Lesson Topics

2.1 Page Navigation 21
2.1.1 Construction Work Areas (CWA) Page 25
2.1.2 Construction Work Packages (CWP) Page 26
2.1.3 Installation Work Packages (IWP) Page 26

2.2 Columns 27
2.2.1 Move Columns 27
2.2.2 Sort Columns 27
2.2.3 Filter Columns 28

Exercise 2.1 — Filter Columns 31
2.3 Data Blocks 32

2.3.1 Add Data Blocks 32
2.3.2 Navigate Data Blocks 34
2.3.3 Manage Data Blocks 34

2.4 Viewsets 40



Exercise 2.2 — Create a Viewset 41
Lesson 2 Review 42
Lesson 2 Summary 42
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2.1 PAGE NAVIGATION

In this lesson, you will explore the layout and start to navigate around the application.

You access InEight Plan through your web browser.  When you first log in, you will land on the All
projects & organizations page within the InEight project platform. Here you can select any your
projects.

From the All projects & organizations page, selecting a project navigates you to the home page for that
project. From your project home page, there are two different ways to access the Work Packaging
module of Plan.

Navigate to the Work Plans Module via the Project Home Page

1. From the All projects & organizations page, select your project.
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2. Select the Work Packaging module by clicking on the Work packaging tile on the right or
selecting Work packaging from the side bar menu on the left.

Navigate to the Work Plans Module via the Navigation Bar

1. From the Projects page, select the second level drop-down menu, hover over Plan, and then
selectWork packaging.
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Title Description

1 First Level Menu
Shows the selected project and provides access to favorites, All projects
and organizations, reports, master data libraries, and suite administration.

2 Second Level
Menu

Displays the list of applications (Control, Plan, etc.), and navigates you to
other project settings.

3 Third Level Menu
Navigates to individual modules inside each application (e.g., Contract >
Bid packages, Plan > Quantity tracking). Options in this menu are
dependent upon the application you are currently using.

4 Help Menu Contains Walkthroughs to walk you step by step through processes within
the module.

5
Notifications and
User Profile

View notifications, user profile and log out.

6 AWP Panel Allows you to access work plans (Work Packaging tab) or see planning
progress (Planning Schedule tab).

7 Actions Menu Select available actions for the current register tab you are viewing.

8 Toolbar Contains functions for the page you are on: add, edit, delete, export,
import, show details, and search.

Overview – Work Plans/Packages Page
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Title Description

9 Block View

View the Work Plans/Work packaging page in a card view layout, the page
displays the most recent saved work package, as well as a card for each
work package associated with the CWA or CWP in the same order and
data as the default grid view.

10 Column Chooser Allows you to add or hide columns to make the plans/packages list user
specific.

11 Query builder
Lets you add, edit, delete, copy, and share queries to search for work
areas and packages.

12 Work
Plans/Packages
Register

List of all work plans and packages in your project.

Overview – Work Plans/Packages Page (continued)

Title Description

1 Breadcrumbs
Navigational links that allow you to track your path from the page you are
currently viewing back to the work plans/packages page. Furthermore,
identifies what and where you are within a work package.

2 Tabs Navigate between different functions on a page. The blue line indicates what
tab you are currently on.

3 Toolbar
Contains functions for the page you are on: add, edit, delete, export, import,
show details, and search.

4 Block View View the Work packages page in a card view layout, the page displays the
most recent saved work package, as well as a card for each work package
associated with the CWA or CWP in the same order and data as the default
grid view.

Overview – Area/Construction/Installation Work Packages Pages
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Title Description

5
Column
Chooser

Add or hide columns to make the plans/packages list user specific.

6 Side Panel Contains a brief summary of your CWA, CWP, or IWP, fed from their overview
and workspace tabs as well as associated components. Percent complete
charts are shown for man-hours and cost in dollars.

Overview – Area/Construction/Installation Work Packages Pages (continued)

2.1.1 Construction Work Areas (CWA) Page
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2.1.2 Construction Work Packages (CWP) Page

2.1.3 Installation Work Packages (IWP) Page

The Construction Work Packages/Work Packages tab displays all the work plans that
you have created or are assigned to as the Superintendent, Engineer, or Foreman. 
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2.2 COLUMNS

Customize columns according to your preferences from the Work plans/packages page. Changes you
make to the placement of your columns will be retained the next time you access any page you have
customized.

2.2.1 Move Columns

Drag and drop to move a column from one place to another to customize your view.

Move Columns

1. On the Work plans/packages page, click on and hold a column header.

2. Drag and drop the column in a new location.

2.2.2 Sort Columns

Sort in ascending or descending (both for alpha and numeric fields) order on any column by clicking
one time on the column header.
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Sort Columns

1. On the Work plans/packages page, click on any column header to sort the column in ascending
order.

l Notice the yellow “up arrow" designating you are sorting in ascending order

2. Click on a column header again (a second time) and the column will filter in descending order.

l Notice the yellow arrow is now pointing down

2.2.3 Filter Columns

Filter columns as a way to see relevant information pertaining to your specific needs.

Filter Columns

1. On the Work plans page, click the filter pyramid of any column header.

2. In the resulting drop-down list, select an operator.
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3. In the first search box, enter a date.

4. Click Filter.

l The table now only shows items that qualify for your filter

l Notice that the filter pyramid is now in yellow indicating that this column is filtered
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5. Select the filter pyramid again. Hover over Filter, then click Clear to remove your filter.

Apply multiple rules to your filter. For example, setting a “Contains” or “Is equal
to” filter for your column would allow you to bring in two distinct results at once.
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Exercise 2.1 — Filter Columns

In this exercise, you will practice filtering columns from the All tab on the Work plans page.

1. Find a discipline by using the column sort function.

2. Remove the columns you do not need in your view.

3. Apply a filter you would use to make the data more relevant.

Congratulations, you have completed this exercise!
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2.3 DATA BLOCKS

On the Workspace tab of an opened installation work package, the work package details are contained
within data blocks. Each data block is a set of columns grouped together based on categories of
information. Data blocks help you to organize and manage all the columns on a page.

Data blocks are customizable, and can be viewed moved up or down in the register. Sort and filter data
block information to organize your view. The information in each data block is displayed in a grid like
format, maintaining a spreadsheet look and feel.

2.3.1 Add Data Blocks

Add Data Blocks

1. From the Work plans/packages page, select a hyperlink under the ID Column for an installation
work package (IWP).
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2. Once you are in an individual work plan, select the Workspace tab.

3. From the Manage workspace slide out panel on the left, select data blocks to include in your
workspace.

Scroll up and down between the data blocks to view all your data blocks.

InEight Inc.  |  Release 21.7 Page 33 of 74

Plan User Guide 2.3 Data Blocks



2.3.2 Navigate Data Blocks

Use the arrows at the top of your data block to view more columns associated with each data block
that are not in the current pane.

The number of dots between the arrows represent how many panes are in that data block.

2.3.3 Manage Data Blocks

2.3.3.1 Context Menu

The Context Menu allows you to customize the order of columns in each data block. You can also use
the Context Menu to add or remove columns from a data block.

Use the Context Menu

1. On your data block, click on the Context Menu icon.

2. Select Choose columns from the drop-down menu.

3. On the resulting slide out panel, search by name or category for a column. Then, select your
column from the list and click on the right arrow to add that column to your data block on the
right.

Page 34 of 74 InEight Inc.  |  Release 21.7

2.3 Data Blocks Plan User Guide



You can also drag and drop columns into your data block. Once in your data block,
you can reorder columns by dragging and dropping.

4. Repeat step three as needed. When finished, click Done.

Each type of data block has its own unique default settings. Default settings include
specific locked columns and total number of columns and panels.

2.3.3.2 Resource Button

Uniquely named for each data block, the Resource Button allows you to add information or resources
to your data block.

2.3.3.3 Daily Plan Icon

The Daily Plan icon is a shortcut that allows you to create daily plans directly from an IWP by selecting
which details to include in a daily plan.
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Clicking on this icon will open a slide out panel to the right where you can view the items you've
selected to include in your daily plan and continue onto the creation window.
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Add and Manage Data Block Contents

1. On your data block, click on the Resource button to add an item.

2. Rename your items by clicking on the item Description cell and entering a new name.
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3. Reorder your items by click on the item Step cell and adding or changing the order number.

You can sort and filter your data block columns.

Delete an item by selecting it then clicking on the red "x" to the right.

2.3.3.4 Pin Icon

The Pin icon allows to flag critical components that will hold up the start of the operation if not
addressed. When pinned, an item will automatically appear under the Constraint Management tab of
the Work plans/packages page. There, you can review and further manage all pinned items.
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l Notice that when you pin an item, the data block row turns blue

To unpin an item, go to the Constraint Management tab, and delete the item. Changing
the status from "open" to "closed" will not unpin or remove the item from the
Constraint Management tab.

You can also manually add constraints under the Constraint Management tab.

2.3.3.5 Completion Indicator

The Completion Indicator allows you to indicate which data blocks are completely planned.

As you check off data blocks, you can track your planning progress from the Planning Schedule tab on
the AWP panel (Work plans/packages page of Plan Work Packaging).
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2.4 VIEWSETS

Create a viewset, or saved view, of your data block workspace to quickly revert back to.

Follow these same steps to save a viewset in Plan Quantity Tracking.

Create a Viewset

1. On the Workspace tab of your installation work package, select the View arrow.

2. Select Save current viewset as from the drop-down list.

3. In the resulting window, enter a name and click Save.

Each viewset is user-specific and can be used from plan to plan.
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Exercise 2.2 — Create a Viewset

Now that you have learned some of the basics of navigating in InEight Plan, from the Work
plans/packages page, create an installation work package viewset that you would use.

1. Select the data blocks you might need. (e.g., Labor Equip, and Budget).

2. Select the desired columns you want to see in each data block.

3. Save your view.

Congratulations, you have completed this exercise!
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Lesson 2 Review

1. How do you know which project you are working in?

a. Breadcrumbs

b. Navigation bar – First level menu

c. Notifications and User profile

2. You CANNOT sort and filter columns if they are in a data block. Only on a register page.

a. True

b. False

3. From where can you customize the order of columns in each data block?

a. Context menu

b. Customization page

c. Data block navigation

d. Settings menu

4. On the Workspace tab of an installation work package, to save the data blocks you have
selected to display on the page, you can create a:

a. Viewset

b. Snapshot

c. Backup

d. Carbon copy

Lesson 2 Summary

As a result of this lesson, you can:

l Navigate the InEight Plan Work plans page

l Manage columns
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l Manage data blocks

l Create viewsets
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LESSON 3 — WORK PACKAGE
MANAGEMENT

Lesson Duration:  60 minutes

Lesson Objectives

After completing this lesson, you will be able to:

l Explain how to manage work packages

l Create a construction work package

l Create an installation work package

l Edit and review work package details

l Import work packages
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3.1 INEIGHT PLAN WORKFLOW – WORK PACKAGE
MANAGEMENT

3.2 WORK PACKAGE MANAGEMENT OVERVIEW

3.2.1 What is Advanced Work Packaging (AWP)?

Advanced Work Packaging (AWP) is a standardized way to plan the execution of a construction
project including design, procurement, and installation. AWP aims to change the planning process to
be execution driven: approaching the beginning of your construction project with the end in mind. In
the past, planning was siloed, Engineering first, then Procurement, and finally Construction. AWP starts
with the priorities of Construction and or commissioning and works backwards.

The Work Packaging module of InEight Plan provides an organized platform to break down your project
into manageable scopes of work. Work packages can be developed to include all items necessary to
complete the scope as well as all constraints that would impede progress.
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3.2.2 Work Packages

There are three levels of work package definition that can be used in InEight Plan:

l Construction Work Area (CWA)

l Construction Work Package (CWP)

l Installation Work Package (IWP)

Scenario

Imagine you are working on a project with the following scope: 30 modules in which you need to
complete earthwork, foundations, and erect the steel support structures.

Using the scenario above as an example, assume that you initially break the project into two
construction work areas (CWA): North Area and South Area. You break each area of work into three
different construction work packages: Earthwork, Foundation, and Steel Erection. From there, you can
break each construction work package into multiple installation work packages so you can plan at a
detailed level and identify the specific constraints, components, safety and quality risks.
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Construction work areas (CWAs) are created for the project or organization in the
Configure CWA and project values page prior to defining construction work packages.

3.2.2.1 Construction Work Package (CWP)

A construction work package (CWP) defines a logical and manageable division of work within the
construction scope. CWPs are aligned with the project execution plan (which includes the construction
plan) and the WBS. The division of work is defined such that CWPs do not overlap within a discipline.
CWPs are to be measurable and in alignment with project controls. CWPs are the basis for the
development of detailed installation work packages. They should also align with engineering and
procurement work packages. A typical CWP includes the following:

l Safety requirements

l At least one EWP

l Schedule
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l Budget (work hours/cost/productivity)

l Environmental requirements

l Quality requirements

l Special resource requirements

A CWP may be divided by area, system, or as otherwise determined by the project (construction)
execution plan. In general, it is better to develop CWPs by discipline. A large project will likely contain
multiple CWPs. CWPs can be the basis of contractual scopes of work. A contractual scope may contain
more than one CWP. Complete specifications of CWPs grow over time to include productivity factors,
detailed cost reports, and other considerations.

3.2.2.2 Installation Work Package (IWP)

An installation work package (IWP) is the deliverable that enables a construction work crew to perform
work in a safe, predictable, measurable, and efficient manner. An IWP is scoped to be manageable and
“progressable”; it is typically of limited size such that a crew can complete the work in about a week.
An IWP contains the necessary documentation supporting workface execution. IWPs should be
approved by the responsible stakeholders, and all constraints should be completed before issuance to
the field. A typical IWP includes the following:

l Work package summary – inclusive of description of work, location, system or facility code,
originator, contact information, sequenced work steps, reference documents, estimate of work
hours and quantities, cost codes, witness or hold points, and special comments quantity work
sheet

l Safety hazard analysis, specific to tasks in work package

l Material Safety Data Sheet

l Drawings (engineering and vendor design)

l Specifications (engineering and vendor design)

l Change documents (i.e., field change request, deficiency report/non-conformance report and
design change notice)

l Manufacturer’s installation instructions model shots

l Bills of Materials

l Required tools

l Installation test results forms

l As-built documentation
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l Inspection checklists

l Completion verification signatures

All elements necessary to complete the scope of the IWP should be organized and delivered before
work is started. As the originator, you should cover the work with the responsible safety, quality,
superintendent, and craft personnel in a preparatory meeting, with special focus on anticipated
constraints.

Generally, the scope of work associated with the IWP should be small enough that it could be
completed by a single foreman and crew within a pre-defined block of work hours. Work hour blocks
should be between 500 and 1,000 hours. An IWP contains all applicable and pertinent documents in
support of safe and efficient installation of a specific portion of a system by a given trade. These
documents are written specifically for the crew performing the activity.

3.3 WORK PACKAGE CREATION

The first step in utilizing the Work Packaging module is to set up your work package structure.

3.3.1 Create a Construction Work Package (CWP)

The following steps walk you through creating a construction work package.
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Create a Construction Work Package (CWP)

1. From your project's home page, navigate to the Work packaging module.

2. Click on the Action menu and select Configure CWA and project values from the drop-down
list.

3. Click on the Add icon on the left toolbar and select Construction work package – CWP from the
drop-down list.
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Construction work packages and installation work packages can also be created
within the construction work areas, for example the North construction work area,
by clicking on the North construction work area folder then select the add button.

4. In the new dialog box, name your CWP.

Note that the CWP name automatically begins with “CWP-“ by default. You can
erase it.

5. Click Add.

Your created CWP will be located in the Unassociated packages folder by default
when you create them outside of a construction work area folder.
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3.3.2 Edit Work Packages

After creating the work package, you may need to go in and edit the details. This includes:

l Schedule start and finish dates

l CWP Description

l CWA description and ID

l Plan Status

l Other fields
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Edit a Work Package

1. From the Work plans/packages page, select the hyperlink ID on your newly created package.

2. Select the Construction Work Package Overview tab.

3. Under CWP description, enter a description.

4. In Start Date, select a date.

5. In End Date, select a later date.

6. Select an Engineer.

7. Select a Planner.

8. Select a Superintendent.

The Engineer, Superintendent, and Planner fields are validated fields and will bring
up a list of people from which to select, once you enter a character.
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9. Now that you have all the CWP overview details, you can go back to the Work plans/packages
page by selecting Work packaging in the breadcrumbs.

3.3.3 Copy Work Plans

You might need to create the exact same work package for a new area with only a few small changes.
Instead of repeating the entire process of creating a new work package, your best choice would be to
create a work plan from an already existing one, making the few small changes as necessary. 
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Copy a Work Package

1. On the Work plans/packages page, select your previously created work plan, then select the
Copy icon.

You can only copy one plan/package at a time.

l This brings up a new dialog box for you to select what information to carry over

2. Rename the work plan.

3. Uncheck Overview page andWorkspace (all data blocks). 

4. Click Copy to finish creating your new work plan.
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3.3.4 Create an Installation Work Package (IWP)

Continuing with the scenario above, you will create an installation work package.

Within each installation work package, you can assign the labor, components, equipment, materials,
and other aspects you need to complete the work.
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Create an Installation Work Package (IWP)

1. From your project's home page, navigate to the Work packaging module.

2. On the Work plans/packages page, select the Add icon and select Installation work package -
IWP.

3. In the Add IWP dialog box, name your work package and click Add.
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3.3.5 Group Work Packages

After creating work packages, you can group them underneath the plans you have created. This helps
with the organization and planning of the work. 

Group a Work Package

1. On the Work plans/packages page, select a work package.

Notice that CWPs and IWPs have different icons.

2. Click the Move into CWP icon.
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You can also group installation work packages into construction work packages by
clicking anywhere in the row for the installation work package and dragging it over
top of the desired construction work package.

3. In the Move into CWP dialog box, start typing the name of your construction work package.

4. Select the CWP you want to move it to, then clickMove to move the package to finish grouping
your packages.

You can also group construction work packages into construction work areas by
editing the CWP in the Construction Work Package Overview tab, then selecting the
appropriate CWA ID or CWA Description from the drop-down.
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3.4 INSTALLATION WORK PACKAGE DETAILS

Installation work packages include the details of a group of activities. The details in the work package
include installation sequence, components, labor, equipment, safety and quality concerns, and other
aspects of the work package. When ready to share, you can attach external files and send to print as a
PDF. Or, if you are integrated with InEight Document, you can easily send packages and documents.

3.4.1 Work Package Overview Tab

When you open an installation work package from the Work plans page, the Overview tab is similar to
the construction work package Overview tab, but you can now define settings specific to the
installation work package. For example:

l The engineer may be different for this particular package and might report to a different
engineer than assigned at the CWP level

l The IWP’s start and end dates might also be a smaller time period than the CWP’s schedule start
and finish dates

Installation Work Package Overview

1. On the Work plans/packages page, select the hyperlink ID of your installation work package.

2. In the Overview tab of your installation work package, enter a description in the Description
field.

3. From the drop-down list in the Discipline field, select a discipline.

4. For Type of work, input short description.

5. From the drop-down list in the Risk field, select a risk level.

6. Select a Start and End date.

7. Select a Planner.

8. Select a Superintendent.

9. Select an Engineer.

10. Select an Executor.
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3.4.2 Installation Work Package Workspace Tab

The Workspace tab is where the majority of your planning is accomplished. Here you can enter the
planned labor, materials, equipment, components, among other aspects of the plan. You enter these
details using data blocks. Some data blocks are open entry fields, such as safety, environmental, and
work sequence. However, other data blocks use validated fields based off previously entered
information. These include Budget, Component, and Equipment data blocks.

The Labor data block is an open entry field, unless you enter an actual labor resource.

Installation Work Package Workspace

1. On the Work Packages tab of the Work plans/packages page, select the hyperlink ID of your
installation work package.

2. From the Installation work package page, select the Workspace tab.
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3. Select the View menu and change your view to your previously created viewset (see General
Navigation).

4. In the Work sequence data block, add work sequence steps by clicking on the Resource button
and enter details for your project.

Create a hold point by clicking in the Hold Point field and select Yes.

5. In the Labor data block, add labor by clicking Add labor from resources and enter details for
your project.
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6. In the new dialog box's Project Resources tab, search for employee names and click the Add icon
and enter details for your project.

You can search based off any of the fields associated to the employee (e.g.,
Employee ID, Trade). 

You can add multiple employees at a time in this dialog box. Only employees who
can be added to daily plans will show up in the drop-down selection – See your
Account Administrator if you do not see an employee.

You can also add generic labor from assigned WBSs in the Estimate/Control
Resources tab. You must first add a component associated with the appropriate
WBS to the IWP.

7. In the Equipment data block, add equipment by selecting Add equipment from resources and
enter details for your project.

You can also add generic equipment from assigned WBSs in the Estimate/Control
Resources tab. You must first add a component associated with the appropriate
WBS to the IWP.
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8. In the Activity Components data block, add equipment by clicking Add Activity components by
WBS and then entering details for your project.

A component can only be present in one package at a time. It cannot be in both the
CWP and its child IWP due to percent complete tracking purposes.

If the work package is assigned to a work area, the activity component's location is
updated to the work area in Quantity tracking and can no longer be changed in that
module.

9. In the Safety data block, add steps by clicking Add safety step and enter details for your project.

10. On the Breadcrumbs bar, selectWork packaging to go back to the Work plans/packages page
and view your completed work plan and work package.

3.4.3 Installation Work Package Constraint Management Tab

From the Constraint Management tab, you can review items pinned in the Workspace tab or manually
add new constraints. Assign constraints and due dates out to project members, and change the
constraint status from open to closed when resolved.
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3.4.4 Installation Work Package Documents Tab

Add, edit, and share IWP documents from the Documents tab. As documents are updated, get the
latest information by looking for the revision number, modifier, and date of modification.

You can add attachments to the Lesson learned, Quality forms, Temporary structures, and Work
sequence data blocks from the Workspace tab. These additions show in the Documents tab.

3.5 WORK PACKAGE IMPORT AND EXPORT

3.5.1 Import Template

Creating and copying work packages can be time consuming. You can use an Excel import template to
upload multiple work packages with their overview information already populated.

Create Work Packages from Excel Import

1. On the Work plans/packages page, click on the Export icon, and select to exportWith Data and
open the export file.

Excel templates without data are used for creating new components from scratch,
usually during project setup.

Excel templates with data are typically used to update existing work
plans/packages.
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2. Open the export file.

l This opens up the Excel template to use for the import. It also contains the data from the
current work packages on the Work plans page

l You may need to select Enable editing at the top of the spreadsheet prior to entering data

3. Input information into your template to be uploaded. At the bottom of the list, add information
for the following categories:

l Name

l Package Type

l Description

l Assign the proper CWP to your work package in the CWP ID field

4. Delete all the work packages that came with the template.
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When you import a template to Work packing with a blank value in a field, the
previous value is not deleted. If want to delete a value when importing, you must
type null in the field.

5. Save this Excel file to your desktop.

6. In InEight Plan, on the Work plans/packaging page, click the Import icon.

l An Import data from template window appears

7. Click Browse to find your saved template.

8. Click Import.

l The import file is added to the import queue

l To see all your import files and their statuses, click View file import queue
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You can continue working in the application while your imports are
processed. A notification tells you if your file is imported successfully or not.

If you have an error, check that the name of your work package is not the
same as an existing work package.

9. Click Close.

3.5.2 Export to Another Project

The following Step by Step shows you how to export some or all of a work package to another project.

3.5 Step by Step 1 — Export Work Package to Another Project

1. Select a work package.

2. Click the Export icon, and then select To other project from the drop-down list.

l The Export work packages dialog box opens

3. Select a destination project, and then click Next.

You must have permission to create work packages in the destination project to
export to that project.

4. Select the pages and individual data blocks you want to export.
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The Documents page is shown in the dialog box but cannot be selected to copy.

You can only export data that is entered as free text. You cannot export project-
specific data such as components.

5. Click Export.

3.5.3 Import from Another Project

The following Step by Step shows you how to import some or all of a work package from another
project.

3.5 Step by Step 2 — Import Work Package from Another Project

1. Select a work package.

You must have permission to create work packages in the destination project to
import into that project.

2. Click the Import icon, and then select From other project from the drop-down list.

l The Import work packages dialog box shows

3. Select an origin project, and then click Next.

4. Select origin work packages, and then click Next.

You can import from multiple work packages at the same time.

5. Select the pages and individual data blocks you want to import.

The Documents page is shown in the dialog box but cannot be selected to copy.

You can only import data that is entered as free text. You cannot import project-
specific data such as components.

6. Click Import.
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Exercise 3.1 — Enter Work Package Details

Now that you have learned to create work packages and fill out all details, create your own
construction work package (CWP) and installation work package (IWP) using the method you prefer.
Make sure to fill out all details for your installation work package.

1. Include at least one safety item.

2. Include at least two components.

3. Include at least two labor resources.

4. Include at least two pieces of equipment.

Congratulations, you have completed this exercise!
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Lesson 3 Review

1. This type of work package allows you to manage a smaller, more detailed scope of work
that is “progressable”.

a. Installation work package

b. Construction work package

c. Advanced work package

d. Discipline work package

2. You can group _______________ under ______________ to organize your work.

a. CWPs, IWPs

b. IWPs, CWPs

c. work plans, work packages

3. On the Workspace tab, what data blocks contain open entry fields? (Select all that apply)

a. Labor

b. Equipment

c. Safety

d. Budget

e. Component

f. Work sequence

g. Environmental

4. Utilizing the import template, you can upload which of the following?

a. Construction work packages

b. Installation work packages

c. a & b

d. None of the above
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Lesson 3 Summary

As a result of this lesson, you can:

l Explain how to manage work packages

l Create a construction work package

l Create an installation work package

l Edit and review work package details

l Import work packages
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